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Welcome 
 

Thank you for purchasing the Parallax SX-Key/Blitz development system. We have done our best to 
produce a full-featured, yet easy to use development system for the SX microcontrollers. The result is 

the SX-Key and the SX-Blitz; very tiny, full-featured development tools with a Windows 95 and higher 
versions interface. We hope you will find this system as enjoyable to use as we do. 

This manual is written for the SX20/28 chips with a date code of AB9921AA or later, and SX48/52 chips 
with a date code of AB0001A or later. 

Older chips are not supported by this manual or the SX-Key development system. 
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1 Introduction to the SX-Key/Blitz Hardware 
 

The SX-Key/Blitz hardware consists of the programmer unit, a four-pin programming interface and a 
standard, female serial port connector (DB9). The serial port connector should be plugged into an 
available standard, straight-through serial cable on an IBM-compatible PC. The four-pin connector on 
the SX-Key/Blitz board should be connected to four pins (VSS, VDD, OSC2 and OSC1) of the SX chip. 
Take care to connect it in the right orientation because this connector is not indexed. 

Figure 1 - Connecting the SX-Key/Blitz 

The SX-Key/Blitz is powered by the target circuit’s power supply and programming and debugging 
takes place over the oscillator pins. The power supply to the SX-Key/Blitz must be +5 V DC. If an 
external crystal, resonator or RC circuit is used, the SX-Key/Blitz can usually remain connected to the 
SX chip for programming purposes, without affecting the operation of the circuit. When debugging, the 
SX chip must not have an external clock source since the SX-Key’s internal programmable oscillator 
must be used. The SX-Blitz can only program SX chips, it cannot debug them.  

Each SX microcontroller contains the necessary debugger hooks required to perform SX in-circuit 
debugging. No other supporting chips are necessary for the debugging process. During debugging, the 
SX-Key provides the oscillator signal to drive the SX microcontroller until such time that a breakpoint is 
hit or a single step or stop mode is initiated. 

Figure 1 - Connecting the SX-Key/Blitz shows all the connections necessary to program, debug and run 
the SX microcontroller. An external resonator or crystal should be connected to the OSC1 and OSC2 
pins to run the SX if the SX-Blitz is used, or if the SX-Key’s internal clock oscillator is not used. 

 

4-pin programming 
interface 

SX-Key or SX-Blitz 
programmer device 

DB9 serial port 
connector 

O
S

C
1

O
S

C
2

V
D

D
V

S
S

R
e
v 

F
S

X
-K

e
y

1

2

4

3

21

5

6

8

7

9 20

26

25

23

24

22

27

28

RC7

OSC2

OSC1

MCLR

RC3

RC4

RC5

RC6

VSS

n.c.

VDD

RTCC

RA2

RA1

RA0

n.c.

RC2RA3

16

10

11

13

12

14 15

18

19

17

RB6

RB7

RC0

RC1

RB3

RB2

RB1

RB0

RB5RB4

S
X

-2
8

+5+5

Vss



1 Introduction the SX-Key/Blitz Hardware 

Page 14 • SX-Key/Blitz Development System Manual 2.0 • Parallax, Inc. 

The SX-Blitz is designed to be a lower-cost device for programming the SX chips only (no debugging 
features are available). The SX-Blitz and SX-Key use the same interface software for programming, 
however, debugging features will not work with the SX-Blitz. 

NOTE: Since the SX-Blitz and SX-Key function almost identically, they will be referred to as the SX-
Key/Blitz, except where there are distinct differences. 
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2 Installing the SX-Key/Blitz Software 
 

Before following the steps in the next chapter, you should first install the SX-Key/Blitz interface on 
your computer’s hard disk. 

The SX-Key/Blitz Interface consists of the integrated editor, programmer, and debugger software. The 
following system requirements are a minimum for using the SX-Key/Blitz Interface: 

• 80486 (or higher) IBM or compatible PC; 

• Windows 95 or higher operating system; 

• 64 Mb of RAM; 

• 3 Mb of available hard drive space; 

• CD-ROM drive, or access to the Internet; 

• 1 available serial port. 

To install the SX-Key/Blitz Interface:  

1. Insert the Parallax CD-ROM in an available CD-ROM drive. 

2. Use the CD's automatic browser to navigate to the Software section. 

3. Expand the SX-Key & SX-Blitz folder. 

4. Select the 18/28/48/52-pin SX chips (SXKey.exe) item. 

5. Click on the Install button. 

6. When prompted for the type of installation, select “Typical” in order to have the software installed 
in the “Programs\Parallax Inc\SX-Key v2.0” folder. Select “Custom” when you want to change the 
default installation options, like the installation folder. 

7. After the setup has finished, you will find a shortcut on the desktop, and a new “Parallax Inc” 
program group in the Start menu. 

You may also download the software from the Parallax web site. There are two different file versions 
available. One has a size of about 1.2 MB, and the other one of 4.6 MB. When you use the smaller one, it 
is necessary to have an Internet connection active while installing the software. Select any folder where 
the downloaded file shall be stored, and then run “Setup_SX-Key_Editor.exe” from this folder. 

After you have successfully installed the SX-Key Editor and start it the first time, the dialog shown 
below opens: 
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Figure 2 - First Time Running Window 

 
This is to remind you that you should review some basic configuration settings first. Click the OK but-
ton, and press Ctrl-U to open the Configuration dialog shown to the right. 

The only setting that is important for now is the selection of the serial port to which you have connected 
the SX-Key/Blitz. 

Figure 3 - Configure Window 

The configuration dialog allows you to select COM1, COM2, COM3, or COM4. 

Click the radio button in the “Serial Port” section that matches your installation. 

Make sure that the remaining options are set to the defaults as shown here, and then click “Okay” to 
close the configuration dialog window. 

You may keep the SX-Key Editor active because you will need it to perform the next steps below. 
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3 Quick Start Introduction 
 

This chapter is a quick start guide to connecting the SX-Key/Blitz and programming the SX 
microcontroller. Without even knowing how the SX-Key/Blitz and the SX chip work, you should be 
able to obtain satisfactory results from the steps that follow. 

3.1 Connecting and Downloading to the SX Tech Board 

In order to get familiar with how the SX-Key/Blitz Development System works, we’ll use the SX Tech 
Board to program and run a 28-pin SX chip. 

Keep in mind that the SX Tech Board is not a programmer; rather the SX-Key/Blitz is the 
programmer/debugger device while the SX Tech board is a type of prototyping board. Follow these 
steps to connect and download a program: 

Figure 4 - SX Tech Board with SX chip inserted 

1) Plug an SX28AC/DP into the 28-pin LIF socket on the SX Tech board as shown in Figure 4 - SX Tech 
Board with SX chip inserted. Make sure it is oriented so that the half-moon notch in the chip faces 
away from the “Reset” button. 

Power 
Jack 

Power 
Indicator 

Reset 
Button 

SX microcontroller (28-pin DIP) properly 
inserted into LIF socket. 

4-pin Programming 
Header 

Resonator 
Socket 

Breadboard 
Prototyping 
Area 
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2) Connect the SX-Key/Blitz to a serial cable, and the serial cable to the serial (COM) port on the PC 
that you have selected in the “Configure” dialog of the SX-Key/Blitz software. 

3) Connect the SX-Key/Blitz to the 4-pin programming header with the VSS, VDD, OSC2 and OSC1 
indicators lining up with the same indicators on the board Note that the programming header is not 
indexed. Therefore, double-check the correct orientation of the SX-Key/Blitz. 

4) Insert one end of a 470 ohm resister into the RC7 socket (next to the upper left side of the 
breadboard). Insert the other end of the resister into any hole in the breadboard. 

5) Insert the shorter leg of an LED into the breadboard hole that is closest (horizontally) to the resister 
leg. Insert the other leg of the LED into one of the VDD sockets (next to the top side of the bread-
board). 

6) Plug the power supply into the SX Tech board and into an available wall outlet. (The power 
indicator should light up). 

7) If it is not still active, start the SX-Key Editor now. 

8) In the SX-Key Editor window, pull down the File menu and select “Open” (or press Ctrl-O). In the 
browser window that appears, select and open the led28.src file. (The led28.src source code should 
appear in the SX-Key code window). 

9) Pull down the Run menu and select Run (or press Ctrl-R). (The SX-Key software should assemble 
the code and begin the programming process). 

Congratulations! You have just programmed the SX microcontroller with the SX-Key/Blitz 
Development System. The program in the SX microcontroller should start running. The LED should 
flash on and off (if wired correctly). 

In case you get an error message after you have selected the “Run” option, make sure that you did not 
modify the source code text in the editor window. If you did, simply re-load the original text by 
opening it again, and then repeat the steps described above. 

Should an error message like “SX-Key not found on COMx” appear, check that you have selected the 
right serial port for communication with the SX-Key/Blitz, and that the serial cable is correctly 
connected to the PC, and to the SX-Key/Blitz on the other end. Also make sure that the SX-Key/Blitz is 
correctly placed on the 4-pin programming header, and that the SX Tech board is powered, i.e. the 
power indicator LED is active. 
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4 The SX-Key/Blitz Interface 
The SX-Key/Blitz interface is an integrated editor, programmer, and debugger. All the functions of the 
SX-Key and the SX-Blitz are available through this single software interface. 

Throughout the rest of this manual, the SX-Key/Blitz interface will be referred to as the SX editor, or 
more simply, the editor. 

4.1 Starting the SX-Key/Blitz Software 

Figure 5 - The SX-Key Icon 

During installation, a shortcut was automatically placed on the Windows desktop. Double-click on the 
SX-Key icon to launch the SX-Key/Blitz interface. In case, the Icon has been deleted from the desktop, 
you can also start the software via the Windows Start button. Navigate to the Parallax Inc. program 
group and select “SX-Key v2.0” there. 

4.1.1 Command Line Switches 

It is also possible to start the SX-Keys software together with parameters from a command line, e.g. 
using the Windows “Run…” option, or from the DOS command line. The Syntax is: 

 SxKey /<switch> {/<switch>…} <File name> 

When you specify a file name with a “.src” extension, the editor window will open, displaying the 
contents of the source code file. When you specify an “.sxh” extension instead, the hex file will be 
opened into the device window. 

The /r switch is used to open a file in read-only mode, i.e. it can be displayed but not modified in the 
editor or in the device window. 

For example 

 SxKey /r test.src 

opens the source file named “test”, and displays it in the editor window and 

 SxKey /r test.sxh 

opens the hex file named “test”, and displays the device window. In both examples, the files are opened 
read-only, i.e. they cannot be modified. 

In addition to the /r switch, the switches /1, /2, /3 and /4 are also defined. They are used to select the 
COM port where the SX-Key/Blitz is attached. This will override the setting that has been recently 
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made in the Configure window. It is recommended not to use these switches; they have been 
implemented for compatibility reasons only. 

4.2 The SX Editor 

Figure 6 - The SX Editor 

The SX editor (see Figure 6 – The SX Editor, above) consists of a window containing a menu at the top, 
several shortcut buttons in a tool bar, a list of files that are currently open to the left, and a large text 
area to the right. In the status bar at the bottom, there is the row/column indicator, telling you at which 
row and column the cursor is currently located. The editor window is where your SX source code will 
be entered and edited. Standard Windows editing shortcut keys listed in Table 1 – Editor Shortcut 
Keys, below, may be used in addition to the commands in the Edit menu and the tool bar buttons to 
manipulate the source code. 
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Table 1 - Editor Shortcut Keys 

 Function 
Name 

Shortcut 
Keys 

  Function Description 
 

Copy Ctrl-C Copies selected text to the clipboard. 

Cut Ctrl-X Cuts selected text to the clipboard. 

Paste Ctrl-V Pastes clipboard contents. 

Page Up PgUp Moves editor window one page up. 

Page Down PgDn Move editor window one page down. 

Begin of Line Home Move the cursor to column 1 in the current line 

End of Line End Move the cursor behind the last character in the line. 

Begin of Text Ctrl-Home Moves the cursor to row 1, column 1 in the editor window. 

End of Text Ctrl-End Moves the cursor behind the last character of the text in the editor. 

Tab Tab 
Moves cursor to the next tab position. The tab position can be set in the configu-
ration dialog. 

 

4.3 The Menus 

The SX editor menu bar contains four menus: File, Edit, Run and Help. These menus and their associated 
menu items are each described below. The most important functions can be also selected with one of the 
shortcut buttons in the tool bar that are also shown below. You will find details to some of the functions 
that can be selected via the menus later in this manual. 

4.3.1 The File Menu 

New Creates a new, empty edit window. Use this item to start a new source code 
editing session. You may also click the shortcut button to create a new file. When 
you start the editor software, a blank session will be opened automatically, called 
“Blank 1”. 

 When you select “New” while another editing session is already open, it will be 
moved to the “background” but it will still remain open. The open files list to the 
left displays the names of all open sessions. 

Open… Opens a browse window to locate and load source code files. As an alternative, 
click the shortcut button, or type Ctrl-O to open an existing file. 

 Again, if there is another session already open, it will be moved to the 
background. 

 The names of all currently open files are listed in the open files list to the left of 
the editor window. To switch between the sessions, left-click on the name of the 
file you want to see in the foreground. 
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Close Closes the source code file currently displayed in the editor window. You may 
also right-click on the file name in the open files list, and then left-click on the 
prompt that is displayed to close a file. 

 When the file to be closed has been modified since the last save, a dialog box will 
open allowing you to select whether or not to save the file or abort the close 
operation; i.e. keep the file open in the editor. 

Save Saves the source code file currently displayed in the editor window. The shortcut 
button or Ctrl-S can also be used to save the file. 

 

Save As… Opens a Save As dialog box to save the source code currently displayed in the 
editor window with a designated name. 

Reopen Displays a list of the files that were most recently edited. You may then click on 
one of the list items to open any of these files directly. 

Print… Opens a print dialog box to print the source code currently displayed in the 
editor window. 

Exit Terminates the SX-Key/Blitz editor. 

4.3.2 The Edit Menu 

Undo This menu selection remains inactive until you make a change to the text in the 
editor window. You can then revert the recent changes you have made to the 
text. Ctrl-Z also activates the Undo function. 

Redo This is the opposite of the Undo function. It allows you to restore any changes 
that were reverted by previous Undo actions. This selection remains inactive 
until you have used the Undo function at least once. Ctrl-Y also does a redo. 
After you have re-done an operation, you may undo it again. 

Cut Cuts the selected text from the editor window and stores it in the Windows 
clipboard. Ctrl-X is the equivalent keyboard entry. 

To select text, use one of the standard Windows methods, like moving the mouse 
pointer across the text to be marked with the left mouse button pressed, or move 
the cursor with the cursor keys while the Shift key is held down. 

In order to select complete lines in the text, move the mouse cursor to the left 
margin of the text area until it turns into an arrow, and then click the left mouse 
button. To mark two or more lines, mark the first line, and then drag the mouse 
up or down. 
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Copy Copies the selected text from the editor window and stores it in the Windows 
clipboard. Ctrl-C is the equivalent keyboard entry. 

Paste Pastes the text from the Windows clipboard into the editor window starting at 
the current cursor location. Alternatively, type Ctrl-V to paste text. 

Find Opens the Find dialog box. Ctrl-F is the shortcut key for this function. Enter the 
text (or part of it) you are looking for. If necessary, you may select the options to 
search for whole words only, or to match upper- and lower-case characters. You 
can also specify the search direction, i.e. if the search shall be performed begin-
ning at the current cursor position towards the beginning or end of the text. 

Find Next Finds the next occurrence of the specified text from the most recent Find 
operation.  F3 also performs this function. 

Find/Replace… Opens the standard Windows replace dialog box. Ctrl-H is the shortcut key for 
this function. Again, you have the options to search for whole words only, or to 
match upper- and lower-case characters. 

Go to Line Number Opens a dialog box where you can enter a line number.  Ctrl-G is the shortcut key 
for this function. Click “Ok” to close the dialog, and to position the cursor to 
column 1 in the specified line. 

Clear Errors When errors are encountered while assembling a source code file with the “new” 
default SASM assembler, the lines with errors are highlighted, and the errors 
found are displayed in the status area. Use this menu selection to clear all error 
information. 

4.3.3 The Run Menu 

Assemble Assembles the code. You may also press Ctrl-A, or click the shortcut button to 
start the assembly. When the code in the editor window could be assembled 
without errors, the message “Assembly Successful” will show up in the status 
bar. 

When you use the default “new” SASM assembler and if there are any errors 
encountered in the code, a message box will open, telling you that errors were 
found. Click “Ok” to close the box. At the bottom of the editor window, you will 
notice a new area that contains a list of all errors found during assembly. The first 
error message line is highlighted, and the offending line in the source code is also 
automatically highlighted. 

When there are two or more error lines, double-click on a line in order to jump to 
the offending line in the source code. 
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Make the necessary corrections to the source code, and assemble the code again, 
until no more errors are reported. 

The assembler may also generate warning messages that are shown in the same 
area, together with any errors. With warnings, the code will be assembled, but it 
is a good idea to make the necessary corrections to the source code in order to 
avoid warnings. 

NOTE: Before assembly, the current file will be saved automatically. If you have 
entered code into a new blank editor window,  use the Save function to save the 
window contents under a specific name before starting the assembler. 

Program  Assembles the source code and programs the SX microcontroller (when the 
assembly was successful). Ctrl-P also starts programming. 

 

 

Run Assembles the source code, programs the SX and generates a clock signal. Ctrl-R 
also runs a program. 

 

 

Debug Assembles the source code, programs the SX, generates a clock signal and 
initiates the debug mode. (Not used on the SX-Blitz). Ctrl-D also starts the 
debugging mode. 

 

Debug (reenter) Assembles the source code, assumes that the SX device is already programmed 
with the recent code to be debugged (i.e. does not program the SX again), 
generates a clock signal and enters the debug mode. (Not used on the SX-Blitz). 
Ctrl-Alt-D also re-enters the debugger. 

This option is handy when you have previously terminated a debug session that 
you want to continue later without having made changes to the source code in 
the meantime. 

As long as you add, remove or change WATCH or BREAK directives in the 
source code, you may still use this function to reenter the debugging session 
without downloading the program to the SX. 

Any other changes to the source code require a new download, i.e. you must use the 
Debug option instead, to start the debugger. 
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View List Assembles the source code, and then opens another window that shows the 
contents of the list file generated by the assembler. Ctrl-L also displays the list 
file. The list file will be described in detail later in this manual (see Chapter 7.10 – 
Files Created by SASM).  

Clock… Opens the clock control dialog box to allow the modification of the clock activity 
and frequency. (Not used on the SX-Blitz). Ctrl-K also opens the clock dialog. 
With this function, the SX device’s clock is supplied by the SX-Key, and you may 
test the functionality of an application at various clock rates. 

Device… Opens the device dialog box to allow modification of the SX microcontroller pa-
rameters. Ctrl-I also opens the device dialog box. 

 

Configure… Opens the configuration dialog box to allow modification of the SX-Key/Blitz 
programming interface. See Chapter 4.4.5 – Configure Window for configuration 
details. Ctrl-U also performs this operation. 

4.3.4 The Help Menu 

Contents  Displays information on how to use the WATCH and BREAK directives. 

About Displays the SX-Key/Blitz Development System information box. 

 

4.4 The Windows 

Many menu items open up a separate window for further configuration or monitoring. These windows 
are described below. 

4.4.1 Print Window 

The print window is accessed via the Print… item on the File menu. It is the standard Windows Print 
dialog box that you know from other applications. It allows you to select which printer shall be used, 
and depending on the printer type, various options can be selected. 
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